
General Description for My Personal Diary

This is the information manager you've been looking for!    My Personal Diary lets anyone and everyone 
keep a private diary, journal or log for personal or business use, but that's not all.    Entries are stored in 
encrypted files with optional password protection and OLE support allows you to embed pictures, sounds 
and even other documents directly in your entries.    A    sophisticated search engine allows you to search 
any or all entries by date, for a word, sentence or phrase.    Add to this a complete address    book, to-do 
list and reminder system and have a top notch information manager.

For HOME USERS,    My Personal Diary is an excellent way to keep track of day to day activities, 
thoughts, goals, feelings and to record the important events in your life.    Use the optional password 
protection to keep your entries safe from prying eyes.    Use OLE to embed pictures and sound clips in 
your entries.

For BUSINESS USERS,    My Personal Diary makes the ideal journal or log.    Easily keep track of daily 
activities, notes, contacts, to-do items and virtually any other type of free-form information.      Keep a 
separate journal for each client and store all notes, records and other    documents right in the journal.

For SCIENTISTS and STUDENTS,    My Personal Diary is the perfect log book.    Keep detailed, secure 
records of experiments and projects.    Create a separate log for each experiment or project and keep 
notes organized by date.    Use OLE to store charts, graphs and reports inside your log book.

For ANYONE,    My Personal Diary is a great tool to keep track of virtually any type of information.    Try it 
and you'll love it!

Features include:

· NEW! Improved custom string support with macro capability.
· NEW! Enhanced quick access commands and hot key support.
· NEW! Organizer Internet support.
· NEW! Additional productivity improvements.
· Looks & works like a real diary.
· Unlimited users can share the program on a single computer.
· Powerful organizer with address book, to-do list and fully customizable printing features.
· Include pictures, sounds and OLE objects in your entries.
· Full support for text and paragraph formatting.
· Advanced Print, Search, Import and Export capabilities.
· Spell checker.
· Tray icon support
· Optional password protection and Lockdown option.
· Password Vault to store passwords and account information.
· Browse by date or by existing entry or quickly jump to any date.
· User-defined entries to store other information.
· Complete on-line help.

What’s new in V6.5?

Macros Include macros for the entry date, current date and current time in your custom strings.

Quick Access Drop down toolbar menus for quick access to user-defined entries, insert commands, 
custom strings and categories.    Hot key support has also been added for many of the 



insert functions.

Internet Instantly visit a contact’s web site of send them e-mail with the click of a button.

Minor Fixes Date automatically updates if diary is left open for more than 24 hours.
Correct behavior if start minimized is specified in the shortcut.
Clearer color for dates that have pending items in the to-do list.
Word wrap in scratch pad.

What’s new in V6.1?

Tray Icon Minimize MPD to the system try instead of an icon in the taskbar for convenient, fast 
access to your information.

The Vault A convenient and secure place to store all your passwords

Bullets Support for bullet style in the editor.

Categories Define categories for organizing information.    Easily search using any category.

Lockdown Toggle your diary to locked and “the doors close”, making your information inaccessible 
without your password.    No need to close MPD when you leave your computer.

Minor Fixes Improved to-do list, Improved OLE verb handling

What’s new in V6.0?

OLE support Now you can store pictures, sounds and any other OLE object into your diary.    You can 
use the clipboard to paste objects into your diary or use the Insert Object command on 
the Edit menu.

Compression All entries are now compressed using state of the art compression to reduce file size and 
enhance security.

Encryption All entries are encrypted using a 64-bit encryption engine that is sure to keep out even 
the toughest hackers.

Single File All entries are stored in a single, encrypted, compressed file for maximum data integrity.

Organizer The old address/phone list and to-do list has been replaced with a unified organizer with 
enhanced capabilities.    You can import and export address book entries in standard 
comma delimited text files.

Printing Print any or all entries.    Print daily and monthly (calendar style) to-do lists and 
address/phone lists full page or for personal organizers. Specify individual fields to be 
included.

Toolbars The toolbars can now be placed where you want them.    Dock them, make them floating 
or remove them entirely.

Import Use the new Diary Conversion Wizard to import existing My Personal Diary diaries as 
well as diaries created with other program (in ASCII text format)



Export Export any or all of your entries to RTF or TXT format documents.

User Entries The Treasure Chest has been replaced with user-definable entries.    You can specify a 
title for each and use them to store whatever you like.

Marked Dates By popular request!    Dates that entries exist for are highlighted in the Jump to Date 
dialog box.

Browsing The Browse commands have been enhanced to allow you to browse by date and by 
entry.    Browsing by entry allows you to skip dates that are blank.    You move to the first, 
last, next and previous entries quickly and easily.



Frequently Asked Questions

Q. I have been using a previous version of My Personal Diary (prior to V6.0) and I just upgraded.    How 
do I import my entries into the new version?

A. Use the Diary Conversion Wizard.    The diary conversion wizard is a separate program that is included
with My Personal Diary to convert your existing entries.    You can import a diary created with the 
Windows 3.1 version, the Windows 95 version (V5.x) or any other program that can export it’s entries 
as text files.    See the online help for more information.

Q. When I login on for the first time I don't have a password so what should I enter at the password 
prompt?

A. Click the Create New button to create a new diary or use the Diary Conversion Wizard to convert an 
existing diary.

Q. How do I backup my entries?
A. Use any backup program to backup your diary file and organizer file!    These files are called Diary.ddf 

and Organizer.cdf and are located in the program directory by default.

Q. I forgot my password, what should I do?
A. If there was an easy way around your password then using a password would not make sense.    If you 

forget your password, kiss your entries good-bye.

Q. I have several diary files that I use regularly but I want the same organizer file to open when I open any
of the diaries.    How do I do this?

A. My Personal Diary stores the last opened organizer filename in your diary file.    Open a diary, then 
open the organizer and selected the organizer file to open using the Open command on the File menu 
in the organizer window.    You can specify an organizer file for each diary the same way.    You can 
select the same file for all diaries, a different file for each diary or any combination.

Q. What type of encryption is used in My Personal Diary to encrypt my entries?
A. The encryption used is a proprietary 64-bit method that is suitable for securing data for 99% of users.    

It is not designed to be ultra-secure so additional steps should be taken to ensure privacy of extremely 
sensitive data.    It is next to impossible for anyone short of an expert to decrypt your entries.

Known Problems

1. If you select all the text in the editor and choose delete the margins will be reset to 0.    This happens 
because the rich text format used in the entries stores the formatting data as special characters within 
the text.    When you delete these characters the formatting is also deleted.    Is you experience this 
problem just enter and select the new text then re-format the margins.



Creating and Opening an Organizer File

The first time you open the Organizer, the organizer file will be created (or opened if it already exists) in 
the directory where the program is installed. This file has the same name as your diary file but with the 
extension CDF.    My Personal Diary remembers the last organizer file that was opened and 
automatically attempts to re-open that file the next time you start the organizer.    The last file that was 
opened is stored in the diary so each diary user can specify his/her own organizer file to open 
automatically.    You can also share a single organizer file between multiple users.

You can create a new organizer file by performing the following steps:

1.    Start the Organizer.

2.    Select File|Open on the menu in the organizer window.

3.    Type the name of the organizer file you want to create and specify the directory where you want it to 
be stored.

You can create a new organizer file by performing the following steps:

1.    Start the Organizer

2.    Select File|Open on the menu in the organizer window.

3.    Choose the file you want to open.

Note:    The organizer files are not encrypted.



Logging In

To log in perform the following steps:

1.    Start My Personal Diary

2.    Enter your first name (This allows you to see a list of files you opened recently).

3.    Select the active diary file from the drop down list or click the Browse button to select another file.

4.    Enter your password (leave it blank if you do not require a password)

5.    Click OK.

If you do not have a dairy file already created or you want to create a new diary click the Create New 
button and see Creating a New Diary

How to bypass the login screen

To avoid the log in screen each time you start My Personal Diary you can create a shortcut to your diary 
and specify your diary filename and password on the command line.    When you select the shortcut it will 
start My Personal Diary and automatically log you in.

The format of the command line is as follows:

DRYWIN32.EXE diaryfile password 

* diaryfile and password are optional

If you do not use a password with diary you only need to specify diaryfile and leave password blank.

For more information on creating shortcuts see the Windows documentation.

Notes:

By creating a shortcut to your diary and specifying your password you are making your diary 
available to anyone who has access to your computer.



Creating a New Diary

The first time you use My Personal Diary you will need to create a new diary file to store your diary 
entries.

If you have an existing diary from a previous version of My Personal Dairy (up to V6.0) you will want to 
use the Diary Conversion Wizard to convert it.    See the section on Importing an Existing Diary.

To create a new diary perform the following steps:

1.    Start My Personal Diary.

*    Make sure you do not have a diaryfile and password specified on the command line.    If you do 
the login screen will not be displayed and you will not have the option of creating a new diary.

2.    At the login screen click Create New.

3.    Click Browse to choose a filename.

*    Select the directory then type in a filename (Example: Diary.DDF)

4.    Enter your first name.

*    Do not include any spaces or special characters (Example: Chris).

5.    Enter a password.

*    If you do not want to use a password enter NO PASSWORD as the password.

6.    Verify the password by entering it again.

7.    Click OK.



Importing an Existing Diary

IF YOU ARE UPGRADING FROM V6.0 OR LATER YOU DO NOT NEED TO IMPORT YOUR DIARY.    
IT WILL WORK WITH THIS VERSION UNMODIFIED.

My Personal Diary has come a long way since it was first released for Windows 3.1    Many changes and
enhancements have been made and the structure of the diary has changed significantly.    As a result you 
will need to use the Dairy Conversion Wizard to convert your existing diary created with any version prior 
to V6.0.

The Diary Conversion Wizard is a separate program (DCONVERT.EXE) that is packaged with My 
Personal Diary that you can use to:

- Import diaries created with the Winows 3.1 version of My Personal Diary (through V4.x)
- Import diaries created with the Windows 95 version of My Personal Diary (V5.x)
- Import diaries created by any other program that is capable of exporting in ASCII text format.
 

To use the Diary Conversion Wizard perform the following steps:

1.    Make sure you are not running My Personal Diary.

2.    Start Diary Conversion Wizard 

*    A shortcut should be located in the same place the My Personal Diary shortcut is located (on the 
Start Menu)

3.    Follow the instruction in the wizard.

Notes:

To import a diary using the text format option, your existing entries MUST reside in a single directory, in 
separate files with the following naming convention:

YYYYMMDD.TXT

where:

YYYY is the year (Example: 1997)
MM is the month (Example: 01)
DD is the day (Example: 01)

An entry for January 1,    1997 (1/1/97) would be named 19970101.TXT



Paragraph Formatting

          

          

Select Paragraph|Format…

Paragraph formatting options include left and right indents, tab stops and alignment.

To format a paragraph perform the following steps:

1.    Place the cursor in the paragraph you wish to format.

2.    Select Paragraph|Format.

3.    Enter the left and right indentation.

*    The left and right indents specify the distance (in inches) from the edge of the page to the edge 
of the text.

4.    Check the Bullets checkbox to give the paragraph a bullet style.

5.    Select the desired alignment: left, right or centered.

6.    Click Tabs... to change tab stop positions.

7.    Click OK.

Tabs

The tab stop dialog box allows you to change the tab stop positions.

To add a tab stop:

1.    Enter the position (in inches) of the tab stop from the left side of the page.

2.    Click Add

*    The new tab stop will be added to the tab list if there is not already a tab stop at that position.

To remove a tab stop:



1.    Select the tab stop in the tab list.

2.    Click Remove.

To clear all tabs:

1.    Click Clear.



Creating a New Entry

To create an entry for a given date perform the following steps:

1.    Use the Browse or Jump to Date command to get to the desired date.

2.    Enter your entry.

3.    Select File|Save.



Opening an Existing Entry

 

Select File|Open…

To open an existing entry perform the following:

1.    Select File|Open.

2.    Select the entry you want to open.

3.    Click OK.

Notes:

Entries are listed in tree format, by date.    User defined entries are listed under “User Defined”.

For quick access to user defined entries click the  button next to the open button.



Saving Your Entry

Select File|Save

To save an entry you only need to select Save on the File menu.    You entries are automatically saved 
within your diary file.

Notes:

You can automatically save your without be prompted by choosing the Auto Save option in the 
configuration dialog box.

My Personal Diary will always ask you if you want to save your file if you attempt to close it or exit the 
program.



Deleting An Entry

Select File|Delete Entry

To delete an entry perform the following steps:

1.    Open the entry you want to delete.

2.    Select File|Delete Entry

Notes:

Once you delete an entry it is gone forever.    Use this command with great care.



Browsing Your Entries

Browsing

My Personal Diary is designed to feel like a real diary in that you can browse through your entries as if 
you were turning the pages of an old fashion paper book diary.    You can use the commands on the 
Browse menu or the browser toolbar to browse by date and by entry. You can move forward and 
backwards in intervals of days, months or years or move to the first, last, next or previous entry.

Jumping to a Specific Date

The Today command will quickly bring you to the current date.

You can jump directly to any date by using the Jump To Date command on the browse menu or the Jump 
to Date button.    Simply choose the month and year in the Choose Date dialog box, then click the desired 
day on the calendar.    You will jump directly to the date you selected and if an entry exists for that day it 
will be opened.

Notes:

The dates that entries exist for are highlighted in the date selection dialog box if the option to do so it 
turned on in the configuration dialog box.



Printing Your Entries

Select File|Print...

To print a single entry perform the following steps:

1.    Open the entry you want to print.

2.    Select File|Print.

3.    Do not select any entries.

4.    Click Print.

To print multiple entries perform the following steps:

1.    Select File|Print

2.    Select the entries you want to print.

*    To select a node or an entry check the box to the left of the entry.
*    Checking a node automatically checks all entries and nodes below it.
*    You can select the entire diary, an entire years or an entire month by checking the box next to 

the appropriate node.
*    Click the By Date button to select a range of entries by date.

3.    Click Print to print all selected entries.

Notes:

When you print more than one entry you can choose to start each entry on a new page by checking the 
Start each entry on a new page checkbox.    Without checking this checkbox all entries are printed 
continuously with a few blank lines between each.

Printing an entry prints the contents of the entry.    No additional title is printed before each entry.    By 
default the current date and time is inserted on the first line of each new entry, which makes an excellent 
title line when and if you print your diary.    If you choose to disable this option you will have no way of 
identifying each entry on the printout unless you manually add the date into each entry.



Searching Your Entries

Select Utilities|Find...

To define a new search through multiple entries perform the following steps:

1.    Select Utilities|Find...

2.    Select the entries you want to search in the entry list.

*    To select a node or an entry check the box to the left of the entry.
*    Checking a node automatically checks all entries and nodes below it.
*    You can select the entire diary, an entire years or an entire month by checking the box next to 

the appropriate node.
*    Click the By Date button to select a range of entries by date.

3.    Enter the search text or choose a category from the drop down list.

*    Categories are defined using the Insert Category command on the Edit menu.
*    Check the Case Sensitive checkbox if you want the search to be case sensitive.
*    Check the Match Whole Words checkbox to only match whole words.

4.    Click the New Search button to start a new search.

*    Each entry is opened and the first occurrence of the search text is highlighted.

*    Click the Find Next    button to find the next occurrence of the search text.

*    Check the Next Entry    checkbox if you want to skip to the next entry that contains the search 
text when you click Find Next (otherwise the next occurrence within the same entry will be 
highlighted)



Inserting Pictures and Other Objects

 

Select Edit|Insert Object|OLE Object or 

Edit|Insert Object|Date or Edit|Insert Object|Time or Edit|Insert Object|Date and Time

Inserting an OLE Object

Using OLE you can insert pictures, sounds and other OLE objects into your entries.

To insert an OLE object into your entry perform the following steps:

1.    Select Edit|Insert Object|OLE Object

2.    Choose the object you want to insert.

3.    Click OK.

Inserting the Date and/or Time

To insert the date, time or both perform the following steps:

1.    Select the appropriate command on the Edit|Insert Object menu.

For quick access to the date and time insertion commands click the  button next to the object button.

Notes:

The format of the date and whether the entry date or the current date is used, is determined by the 
settings on the Date and Time page in the configuration.

You can paste objects that are on the clipboard into your entries.    For example, you can copy a picture 
from your favorite graphics program and paste it directly into your diary.

Pictures, sounds and other OLE objects can be very large.    The more objects you insert into an entry the 
larger your diary file will become and the longer it will take to load and save the entry. 



Spell Checking Your Entry

Select Utilities|Check Spelling

The built in spell checker allows you to check the spelling of words in your entries.

Checking an Entire Entry

Make sure no text is selected and select Utilities|Check Spelling.

Checking a Section on an Entry

Select the text you wish to check and select Utilities|Check Spelling.



Inserting a Custom String or Category

 

        

 

Select Edit|Insert Custom or Edit|Insert Category

A custom string is a phrase that you can store for quick insertion in your entries.

A category is a tag that can be used to categorize information.    Categories are easily searched for using 
the Search command.

Since custom strings and categories are very similar they are covered together below

To insert a custom string perform the following steps:

1.    Select Edit|Insert Custom.

2.    Select the string from the list.

3.    Click Insert to insert the string.

4. Click Close.

For quick access to the custom strings click the  button next to the custom button.

To insert a category perform the following steps:

1.    Select Edit|Insert Category

2.    Select the category from the list.

3.    Click Insert to insert the category.

4. Click Close.

For quick access to the categories click the  button next to the category button.

Adding a Custom String/Category



1.    Click the New button.

2.    Enter the text in the edit control below the list.

*    For custom strings you can insert macros representing the entry date, the current date and the 
current time using the appropriate Macro button. These macros are expanded when you insert 
the custom string into your entry.

*    Custom strings can be more than one line. To insert a new line press ENTER.

3.    Click the Add button.

Deleting a Custom String/Category

1.    Select the custom string/category in the list.

2.    Click the Delete button.

Changing a Custom String/Category

1.    Select the custom string/category in the list.

2.    Edit the string/category in the edit control below the list.

3.    Click the Change button.

Reordering the Custom String/Category List

1.    Select the custom string/category in the list.

2.    Click the Up or Down button to move the item up or down.



The Password Vault

Select Utilities|Password Vault

The password vault is a secure place where you can store passwords and other information about your 
accounts for easy access.    Since the password vault is stored within your diary you only need to 
remember a single password (the one for your diary) to have access to all your important information, 
including other passwords.

To add an account to the vault perform the following steps:

1.    Enter the account name, password and notes

2.    Click Add.

To change an account in the vault perform the following steps:

1.    Select the account you want to modify from the account list.

2.    Enter the account name, password and notes

3.    Click Change.

To delete an account in the vault perform the following steps:

1.    Select the account you want to delete from the account list.

2.    Click Delete.

To view information for an account simply select the account from the account list and the information is 
displayed.



Changing Your Name/Password

Select Utilities|Name and Password…

The name and password utility allows you to change the name used with your diary as well as your 
password.    You can also clear the list of files listed in the login dialog box for your name.

To change your name perform the following steps:

1.    Select Utilities|Change Password...

2.    Check the Change Name checkbox.

3.    Enter your new name.

4.    Click OK.

To change your password perform the following steps:

1.    Select Utilities|Change Password...

2.    Check the Change Password checkbox.

3.    Enter your existing password.

4.    Enter your new password.

5.    Verify your new password by entering it again.

6.    Click OK.

To clear the files listed in the login dialog box for your name click the Clear File List In Login Dialog button.
All files except the currently open diary will be removed from the list.    This does NOT actually delete the 
files.    It only the removes the filenames in the most recently used list.

Notes:

After changing your password ALL entries are modified and any previous backups you have are obsolete. 
MAKE A NEW BACKUP IMMEDIATELY AFTER CHANGING YOUR PASSWORD.

The next time you log in after changing your password you will need to use your new password.    YOUR 
OLD PASSWORD WILL NO LONGER WORK.    REMEMBER YOUR NEW PASSWORD.



Exporting Entries

Select File|Export…

The Export… command allows you to save any or all entries as plain text or RTF (Rich Text Format).

To export an entry perform the following steps:

1.    Select File|Export…

2.    Select the entries you want to export

*    To select a node or an entry check the box to the left of the entry.
*    Checking a node automatically checks all entries and nodes below it.
*    You can select the entire diary, an entire years or an entire month by checking the box next to 

the appropriate node.
*    Click the By Date button to select a range of entries by date.

3.    Choose the options

*    Check Save all entries to a single file to save all entries to a single text file
*    Check Export in Rich Text Format to save the entries in RTF (this will preserve formatting) (This 

option is not available if you choose to save all entries to a single file)

4.    Click OK.

5.    Choose the directory and the file name to export to.

Notes:    

Another method of “exporting” an entry is to use the clipboard.    You can select and copy all or part of 
your entry then paste it into another application.    This method is easier and more flexible than using the 
Export... command but requires a Windows application that supports clipboard operations to be used as 
the destination.



Mailing an Entry

Select File|Send…

My Personal Diary provides the standard Send… command for sending an entry (in text format) by e-
mail.    You can use this command to instantly send the current entry to anyone by e-mail.

Your entry is sent in RTF (Rich Text Format) and is NOT encrypted when sent using the Send 
command.

To mail an entry perform the following steps:

1.    Select File|Send…

2.    Choose the profile to use to send the entry.

3.    Click OK.

You must have MAPI (messaging API) support installed on you computer to use this feature.



Configuration

Select Options|Configuration

A property dialog box will appear with tabs representing different sets of options.

The General Tab

The options on the general tab are:

- Flag week end days in date selection dialogs
Check this checkbox to make all days that fall on a weekend appear red in the date selection dialog 
boxes.

- Flag dates that have entries
Check this checkbox to highlight dates that have entries in the date selection dialog boxes.

- Display the organizer (and reminders) at startup
Check this checkbox to display the organizer and reminders when the program starts.

- Auto-save entries
Check this checkbox to automatically save your entries without prompting.

- Create backups
Check this checkbox to create a backup of your diary file when the program starts.    Checking this 
option will use more disk space and cause the program to take longer to start up, but will provide 
extra reliability.

- Minimize to the tray
Check this checkbox to minimize to the system tray instead of an icon in the taskbar.    (You must re-
start the program for this option to take effect.)

- Lock at startup
Check this checkbox to lock when you start the program.

- Entry to open at startup
Select the entry to open automatically when the program starts.    You can choose from the current 
day’s entry or one of the user-defined entries.

The Appearance Tab

The options on the Appearance tab are:

- Show Book Bindings
Check this checkbox to show the book bindings.

- Show Ruler
Check this checkbox to show the ruler.

- Show Title
Check this checkbox to show the title bar.



- Show Cover
Check this checkbox to show the book cover.

- Editor Color...
Click this button to set the editor's background color.

- Cover Color...
Click this button to set the color of the book's cover.

- Title Color...
Click this button to set the color of the title background.

- Title Text Color...
Click this button to set the color of the title text.

The New Entry Defaults Tab

The options on the New Entry Defaults tab are:

- Left
Enter the default left margin in inches.    This value is used to set the left margin on all new entries.

- Right
Enter the default right margin indent in inches.    This value is used to set the right margin indent on all
new entries.

- Header
Enter the header size in inches.    This value is only used when printing your entries.

- Footer
Enter the footer size in inches.    This value is only used when printing your entries.

- Font...
Click this button to set the default font and color for new entries.

The Spelling Tab

The options on the spelling tab are:

- Ignore Words in Uppercase
Check this check box to ignore words in uppercase (Example MPDIARY)

- Ignore Words Containing Non-alphabetical Characters.
Check this checkbox to ignore words containing non-alphabetical characters (Example testing123)

The Date and Time Tab

The options on the date and time tab are:

- Available Date Formats
Choose the format of the date you want used throughout the program.



- Available Time Formats
Choose the format of the time you want used throughout the program.

- Insert the date in new entries
Check this checkbox to automatically insert the date in all new entries.

- Insert the time in new entries
Check this checkbox to automatically insert the time in all new entries.

- Use Entry Date
Check this checkbox to use the entry date instead of the current date when inserting the date.

User Defined Entries Tab

The user-defined entries tab lets you specify the names of the user-defined entries

To change the name of a user-defined entry perform the following steps:

1. Select an entry in the user entry list.
2. Modify the name in the edit control below.
3. Click Change to change the name of the entry.

Notes:

The option settings are stored in your diary file.    You must specify settings separately for each diary you 
create.



Check this option to show weekend days in red in the date selection dialog boxes.



Check this option to highlight dates that have entries in the date selection dialog boxes.



Check this option to display the organizer and reminders when you start My Personal Diary.



Check this checkbox to automatically save your entries without prompting.



Check this checkbox to create a backuo of your diary file when the program starts.    Checking this option will use more disk space 
and cause the program to take longer to start up, but will provide extra reliability.



Check this checkbox to minimize to the system tray instead of an icon in the taskbar.
(You must re-start the program for this option to take effect.)



Check this checkbox to lock when you start the program.



Select the entry to open automatically when the program starts.    You can choose from the current day’s entry or one of the user-
defined entries.



Check this checkbox to show the book bindings.



Check this checkbox to show the ruler.



Check this checkbox to show the title bar.



Check this checkbox to show the book cover.



Click this button to set the editor's background color.



Click this button to set the color of the book's cover.



Click this button to set the color of the title background.



Click this button to set the color of the title text.



Enter the default left margin in inches.    This value will be used to set the left margin on all new entries.



Enter the default right margin indent in inches.    This value will be used to set the right margin indent on all new entries.



Enter the header size in inches.    This value is only used when printing your entries.



Enter the footer size in inches.    This value is only used then printing your entries.



Click this button to set the default font and color for new entries.



Lists the available date formats.



Lists the available time formats.



Check this option to automatically insert the date in all new entries.



Check this option to automatically insert the time in all new entries.



Check this option to use the entry date instead of the current date when inserting the date.



Lists the names of the user-defined entries.



You can change the name of the selected user-defined entry here.



Click this button to save the change.



Check this checkbox to skip uppercase words. (Example TESTING)



Check this checkbox to skip words with non-alphabetical characters. (Example Testing123)



Warranty and License Agreement

In the following agreement "software" refers to all files included with this distribution package.

Shareware Information

THIS PRODUCT IS NOT FREE SOFTWARE.    It is distributed as Shareware, which allows you to try it 
before you buy it.    You may evaluate this product for 30 days.    If you decide to continue using it, you 
are required to either register (purchase) it or remove it from your computer.

Shareware gives you the opportunity to fully evaluate a product before spending your hard earned money 
on it.    We're sure you will find this product to be an excellent piece of software so please be honest and 
register if you continue to use it.

REGISTERED USERS ENJOY:

· Full unlimited registered access.
· Elimination of introduction screens.
· Priority technical support.
· Access to additional add-ins.
· Free minor version updates.
· E-mail notification of new versions and products.
· Special offerings.
· And much more...

You may freely distribute the SHAREWARE version provided that 1) you distribute the original distribution 
package containing all the original files 2) it's clearly stated that the software is Shareware 3) no more 
than $5 is charged per copy (only to cover duplication costs if applicable).    If you are a vendor see the 
VENDOR.DOC file for more information.    VENDORS MUST BE GRANTED PERMISSION DIRECTLY 
FROM US BEFORE DISTRIBUTING THE SOFTWARE.

License Agreement

By installing this software you accept the following license agreement:

The software is considered "registered" once the author has received appropriate payment, the 
registration ID has been entered and the software no longer displays the reminder screens.

WHILE THE SOFTWARE IS UNREGISTERED:

You are granted a right to use the unregistered software for an evaluation period of 30 days.    If you 
continue to use the software after the evaluation period you are required to either register or remove the 
software from your computer.

ONCE THE SOFTWARE IS REGISTERED:

You are granted a non-exclusive right to use a single copy of the software on a single CPU.    You may not
distribute registered copies of the software or your registration information.

NO MATTER WHAT:

You may not rent, lease, sell, sub-license, assign, or otherwise transfer the software.    You may not 



reverse engineer, de-compile or disassemble the software.

The author retains title and all ownership rights to the software.    The software and documentation are 
copyrighted.    United States copyright law provides civil and criminal penalties for the unauthorized use, 
reproduction, distribution, and/or sale of copyrighted material.

Warranty

This software comes with the ultimate warranty.    You can try it, use it and test it for 30 days without 
spending a cent.    If you are satisfied with the software (as we hope you will be) then pay for it by 
registering and continue to use it.    If you are not satisfied, remove the software from your computer and 
owe nothing.

CAM DEVELOPMENT DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE WHETHER 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES 
ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED.    NEITHER CAM DEVELOPMENT NOR 
ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF 
THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE EVEN IF CAM 
DEVELOPMENT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS.    IN 
NO EVENT SHALL CAM DEVELOPMENT 'S LIABILITY FOR ANY DAMAGES EVER EXCEED THE 
PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF CLAIM,
THE PERSON USING THE SOFTWARE BEARS ALL RISKS AS TO THE QUALITY AND 
PERFORMANCE OF THE SOFTWARE.    SOME STATES DO NOT ALLOW THE EXCLUSION OF THE 
LIMIT OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE 
LIMITATION MAY NOT APPLY TO YOU.    THIS AGREEMENT SHALL BE GOVERNED BY THE LAWS 
OF THE STATE OF NEW YORK AND SHALL INURE TO THE BENEFIT OF CAM DEVELOPMENT AND 
ANY SUCCESSORS, ADMINISTRATORS, HEIRS AND ASSIGNS.    ANY ACTION OR PROCEEDING 
BROUGHT BY EITHER PARTY AGAINST THE OTHER ARISING OUT OF OR RELATED TO THIS 
AGREEMENT SHALL BE BROUGHT ONLY IN A STATE OR FEDERAL COURT OF COMPETENT 
JURISDICTION LOCATED IN SUFFOLK COUNTY, NEW YORK.    THE PARTIES HEREBY CONSENT 
TO IN PERSONAM JURISDICTION OF SAID COURTS.



Registration, Upgrade and Contact Information

Registration

In order to continue using this software after the 30 day evaluation period you are required to register.    
Registration is the process of paying for the software and entitles you to support, the latest version and 
free minor version updates.    (See Upgrade Policy below) In addition, by registering you'll be doing your 
part to assure that we continue working hard at providing you with quality software at a very low price. 

REGISTERED USERS ENJOY:

· Full unlimited registered access.
· Elimination of introduction screens.
· Priority technical support.
· Access to additional add-ins.
· Free minor version updates.
· E-mail notification of new versions and products.
· Special offerings.
· And much more...

For information on how to register please click the How To Order button on the Shareware screen when 
you start the program. 

Version Upgrade Policy

All registered users are entitled to free updates to all minor versions of the major version for which they 
have registered.    For example, registered users of a product version 3.0 are entitled to all 3.X versions 
for free (when available).    For the free update simply obtain a copy of newer version, install it over your 
old version and use the same ID you received when registering.

This will not work when upgrading to a new major version.    Special pricing is available to registered users
for major version upgrades..    Please contact us for details.

Contacting CAM Development

For additional information, the latest versions and other goodies please visit:

http://www.camdevelopment.com

Send your questions, comments and suggestions to:

E-mail: sales@camdevelopment.com

Phone: Available to registered users.

Mail: CAM Development
P.O. Box 945
Bellport NY 11713-0945






